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Chapter 1 : Getting Started 

1.1 Introduction 
The Touch-8000 series HMI supports Modbus TCP/IP master protocols via its Ethernet port and 
Modbus RTU master protocol via its RS-232 and RS-485 ports. Touch-8000 can link to the ICP DAS 
Modbus PACs and M-7000 I/O Modules easily. For example, it can link to the uPAC-7186EG and 
iPAC-8447/8847 and WinPAC-8147/8447/8847 and i-7188XG and M-7018z or other ICP DAS PAC 
which support the Modbus TCP/IP slave or Modbus RTU slave protocols.  
 

Item     Screen size and available Modbus TCP/IP and Modbus RTU ports 
Touch-8070T 7" color TFT LCD, 480x234  

One 10/100Base-T   ,   COM1: RS-232 / RS-485 (2 wire / 4 wire)  
COM2: RS-232    ,    COM3: RS-232 / RS-485 (2 wire) 

Touch-8104T 10.4" color TFT LCD, 640x480 
One 10/100Base-T , Other serial ports are same as Touch-8070T. 

 

Download Development Software from the Internet: 
Please install the ”EasyBuilder 8000” software (Ver. 2.10 or later version)  first before you can 
program the Touch-8000 series touch HMI.  Please download it at  
ftp://ftp.weintek.com/MT8000/eng/ > “EB8000V210_090306_en.zip” or other newer version number. 
 

User's Manual: 
1. Getting Started manual: this document. (Touch-8000 CD-ROM:\napdos\touch8000\english_manu\) 
2. User's manual:  ftp://ftp.weintek.com/MT8000/eng/UserManual/ > all PDF files. 
 

More Information :      NS-208/NS-205 : http://www.icpdas.com/products/Switch/switch_list.htm 
ICP DAS ISaGRAF PAC:  http://www.icpdas.com/products/PAC/i-8000/isagraf.htm 
WinPAC-8xx7: http://www.icpdas.com/products/PAC/winpac/wp-8x47.html 
Touch HMI: http://www.icpdas.com/products/HMI/touch_lcd/touch_human.htm 
M-7000: http://www.icpdas.com/products/Remote_IO/m-7000/m-7000_list.htm 
 

Ethernet connection: 
Recommend not connecting more than 6 controllers. The more connectted, the slower rate. 
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Pin assignment of RS-485 ports: 
 
The RS-485 Cable Pin assignment between the Touch 8000 and uPAC-7186EG, iPAC-8xx7, WP-8xx7  
or other ICP DAS controller which supports Modbus RTU slave protocols in RS-485 port is as the  
following. (Recommend connect no more than 7 controllers or M-7000. The more connectted, the 
slower communication rate) 
 
Touch-8000 COM1: RS-485    ICP DAS controller or M-7000    ICP DAS controller or M-7000  
   2 Data +   Data +     Data +  
    1 Data -   Data -     Data - 
 

    
Touch-8000 COM3: RS-485    ICP DAS controller or M-7000    ICP DAS controller or M-7000  
   9 Data +   Data +     Data +  
    6 Data -   Data -     Data - 
 
 

Pin assignment of RS-232 ports: 
 
The RS-232 Cable Pin assignment between the Touch 8000 and uPAC-7186EG, iPAC-8xx7, WP-8xx7 
or other ICP DAS Modbus RTU slave controllers is as the following.  
(Only one controller can be connected by the RS-232 cable) 
 
      Touch-8000 COM1: RS-232    ICP DAS controllers 
    2 RXD           TXD 
    3 TXD           RXD 
  5 GND       GND 
  7 RTS  
  8 CTS  
 

 
      Touch-8000 COM2: RS-232    ICP DAS controllers 
    6 RXD           TXD 
    4 TXD           RXD 
  5 GND       GND 
  7 RTS  
  8 CTS  
 

 
      Touch-8000 COM3: RS-232     ICP DAS controllers 
    8 RXD           TXD 
    7 TXD           RXD 
  5 GND       GND 
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1.2: Setting up the IP address and password of the Touch-8000 
To make your PC can connect the Touch-8000 or Touch-8000 can connect to some controllers, please 
setup proper IP address and its password for downloading HMI pictures.  
 
1. First, make sure the DIP SW No. 1 to 4 on the back of the Touch-8000 are all set as OFF. Then 
power up the Touch-8000. 
 

2. Then use your finger to touch the bottom-right corner to make the tools-bar appeared. You may also 
try to use one USB mouse to plug in one USB port on the back of the Touch-8000 to operate it. (If it is 
not easy to click the bottom-right corner of your Touch-8000 , please go to the step 6 on the next page 
to do screen calibration) 

 
3. Then click the fourth item to do further settings. 
Enter the correct password. The default password when shipping out is 111111 . 
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4. After the correct password entered, please click the “Network” and “IP address get from below” to 
setup the IP address and subnet mask of the Touch-8000. 

 

5. Then click on “Security” and “ Download Password” to enter new Password and confirm it. (You 
may use the default password 111111 ). This download password is necessary when user downloading 
HMI pictures from PC to the Touch-8000 . 

 

6. Important  To do calibration or forget the password, please set Dip SW 1 on the back of the 
Touch-8000 as ON and SW 2 to 4 as OFF and then re-cycle the power once. Then the Touch 8000 will 
guide you to calibrate the screen. After that, there will have one “Restore to default password” window 
pop-up. You may click “yes” (or “No” to do calibration only) to make the password become 111111. 
Then do above steps 1 to 5 again.
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1.3: A sample program for connecting the Touch-8000 to ICP 
DAS controllers by Modbus TCP/IP protocols  
To make uPAC-7186EG, WinPAC-8xx7, iPAC-8xx7, I-7188EG & WinCon-8xx7 controllers to be 
accessible by the Touch-8000 HMI, variables in the controllers should be assigned with a network 
address. Please refer to the section 4.1 and 4.2 of the ISaGRAF User's manual. If you are not familiar 
with the ISaGRAF programming, recommend to review Chapter 2 of the ISaGRAF User's manual. 
 
ISaGRAF user's manual : “user_manual_i_8xx7.pdf” and “user_manual_i_8xx7.pdf_appendix”  
   WP-8xx7 CD-ROM: \napdos\isagraf\wp-8xx7\english_manu\   or 
   uPAC-7186EG , iPAC-8xx7 CD_ROM: \napdos\isagraf\8000\english_manu\   or 
   http://www.icpdas.com/products/PAC/i-8000/getting_started_manual.htm  
 
1.3.1: ISaGRAF sample program  
 
Please set the IP address of the ISaGRAF controller to be 192.168.1.180 and mask as 255.255.255.0. 
(This example will use this IP to connect to the Touch-8000) 
 
This ISaGRAF project file is at Touch-8000 CD-ROM:\napdos\touch8000\example\touch1.pia . 
(Please refer to Chapter 9.5 of the ISaGRAF User’s manual to restore it to PC / ISaGRAF workbench.) 
 
Variables used in this example.   

Name Type Attribute Network address Others 
OUT01 Boolean Internal 0001  
Second1 Integer Internal 000B  (Dec. is 11)  Used as 16-bit integer 
VAL1 Integer Internal    000C (Dec. is 12)  Used as 32-bit integer 
F1 Real Internal    000E (Dec. is 14)  32-bit IEEE floating point value 

 
 
A simple Ladder program to get the system time . 

 
After you finish this project, compile it and then download it to the ISaGRAF controller. 
 
(If you are not familiar with the ISaGRAF programming, recommend to review Chapter 2 of the 
ISaGRAF User's manual.)
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1.3.2: Program the Touch-8000  
 
The project file of this example : Touch-8000 CD-ROM:\napdos\touch8000\example\touch_01.mtp 
 
The “EasyBuilder8000” software is for programming many useful pictures for the Touch-8000 series 
HMI. This section illustrates a simple example to program a Touch-8070T. For more information 
about programming on the Touch series, please refer to the Easybuilder 8000 user manual. 
 

Please install the ”EasyBuilder 8000” software (Ver. 2.10 or later version)  first before you can 
program the Touch-8000 series touch HMI.  Please download it at  
ftp://ftp.weintek.com/MT8000/eng/ > “EB8000V210_090306_en.zip” or other newer version number. 
 
User's Manual: 
A. Getting Started manual: this document. (Touch-8000 CD-ROM:\napdos\touch8000\english_manu\) 
B. User's manual:  ftp://ftp.weintek.com/MT8000/eng/UserManual/ > all PDF files. 
 
Steps to program the HMI project: 
 
1. Click on the Windows "Start" button, then click on the "Program" , then click on the 
"EasyBuilder8000" – “EasyBuilder8000”.  

 
The following windows will be displayed. Select the proper model for your application. Here use the 
8070T . 
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Then click ok in the “System Parameter Settings” window. 

 
2. To create a new project, please run “File” > “New” as the following window. 
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3. Then run “Edit” > “System Parameters ...” 

 

Click on “New” to create a new device. Then enter the proper setting for that device as following. Here 
set the IP of PLC as 192.168.1.180 , Port No. as 502 . 
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4. Click on “Save” and entering a name to save the above settings. 

 
 
5. Select the “object list” as the following. 
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Then double-click the “*10: WINDOW_010” .  The “10” window is the starting window (First page) 
when power on the Touch-8000 HMI . 

 
6. Before editing the “10” window, here we are going to create the “11” window as the following. 
Move the mouse cursor to “11” and right click  on the “11”. Select the “New” to create it. 
Select the proper Background color for this new created window. 
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7. Editing the “11” window. 
First click on “*11: Window_011” to get into this window. 

 
Then click on “A” to enter a Text Label and move it to a proper position. 
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Then Click on “Function Key” to create a “change window key” as the following. (for switching to the 
“10” window) 
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Please set proper “shape” , color for “shape” and Label for this function key as the following. Then 
move it to a proper position. 
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8. Now we are going to edit the “10” window. 

 
Create a label “This is Page 1”  as the following. 
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And then create a function key to switch to the “11” window.  
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Please set proper “shape” , color for “shape” and Label for this function key as the following. Then 
move it to a proper position.  
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9. Then we are going to create a bit lamp and two buttons to change the state of the “OUT01” variable 
in the ISaGRAF controller listed in section 1.3.1 . 
 

Name Type Attribute Network address Others 
OUT01 Boolean Internal 0001  

 
Click on “Bit Lamp” and then select “PLC name” as “PLC1” device which we have created in step 3. 
The boolean operation must use “Device type” as “0x” .  The “Address” filed is the “Network 
address” number of the “OUT01” variable in ISaGRAF program. It is number “1” in this example. 

 

Click on “Shape” to setup the proper shape for this bit lamp. 
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Then Click on “Label” to set proper label for state “0” and state “1” . Remember to click on “OK”  
and then move it to proper position as the following figure. 
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10. Then we are going to create the first “Set Bit” button to switch the “OUT01” value to ON. 
Click on “Set Bit”, then set “PLC name” as “PLC1” which we have created in section 1.3.1 . Then set 
“Device type” as “0x” (0x is for Boolean variable) and the “address” as 1 (the network address of 
“OUT01”) . And then set “style” as “Set ON” . 
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Then follow similar step as former to set proper “Shape” and “Shape library” . 
 
And set Label “Set_ON” to state 0  , and move it to proper position as the following figure. 
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Then follow the same step to create the second “Set Bit” button to switch “OUT01” value to OFF . 

 
Then set proper “Shape” and “Shape library” for it. And set Label “Set_OFF” to state 0 . Then we have 
the following figure. 
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11. Here we are going to create a “Numeric Display” to display the “Second1” in the ISaGRAF 
controller. The “Second1” in this example is to get the second number of the controller 's system time. 
The value is between 0 to 59 . Its network address is assigned as 11 in the ISaGRAF program. 
 

Name Type Attribute Network address Others 
Second1 Integer Internal 000B  (Dec. is 11)  Used as 16-bit integer 

 
Please follow the below figure to create one “Numeric Display” . Set “PLC name” as “PLC1” which 
we have created in section 1.3.1 and set “Device type” as “4x” (4x is for integer and floating point 
value). Then set “Address” as 11,  “Left of decimal Pt.” as 3.  Set “Data format” as “16-bit Signed” 
(means the value occupy only 1 Modbus word, signed value between -32768 to +32767) . 
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12. Here we are going to create a “Numeric Display” to display the integer variable “VAL1” in the 
ISaGRAF controller. The “VAL1” in this example is used as 32-bit integer . 
 

Name Type Attribute Network address Others 
VAL1 Integer Internal    000C (Dec. is 12)  Used as 32-bit integer 

 
Please follow the below figure to create one “Numeric Display” . Set “PLC name” as “PLC1” which 
we have created in section 1.3.1 and set “Device type” as “4x” (4x is for integer and floating point 
value). Then set “Address” as 12 , “Left of decimal Pt.” as 10.  Set “Data format” as “32-bit Signed” 
(means the value occupy 2  Modbus words, signed value between -2147483648 to +2147483647) 
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13. To create a “Numeric Input” button for the “VAL1” integer, please follow steps in the following 
figure.  Set “PLC name” as “PLC1” , Device type as “4x” and “Address” as 12 . 
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Click on “Numeric Format” to set “Data format” as “32-bit signed” , “Left of decimal Pt.” as 10 . And 
then move it the proper position as the following figure. 
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Here we can do a tricky way to cover the “########” symbol on the “Numeric Input” button. 
Double-click on the “Numeric Input” button to modify its original settings, then set the same color to 
both of “Shape” and “Font” .  
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Then add one Label “Set VAL1” to the “Numeric Input” button as the following figure. Move it to just 
on the “Numeric Input” button. 
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14. Here we are going to create a “Numeric Display” to display the floating point value “F1” and a 
“Numeric Input” to modify the value of “F1” .  
  

Name Type Attribute Network address Others 
F1 Real Internal    000E (Dec. is 14)  32-bit IEEE floating point value 

 
The way to create them is similar as the former step 12 and step 13. However there is one quick way to 
create them. Just copy them from the former objects as the following. 

 
Then run “Copy” and then run “Paste” . Move the new copied objects to proper position. 
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To change the property of the new copied object, use mouse to two-click on it. 

 
Then modify the “Address” to 14. (the network address of variable “F1”) . Then click on “Numeric 
format” to set the “Data format” as “32-bit Float” , “Left of decimal Pt.” as 5 , “Right of decimal Pt.” 
as 3 , “Input low” as -9999.999  and “Input high” as +9999.999 .   
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Then two-click on next “Numeric Input” object to modify its property. 

 
Then modify the “Address” to 14. (the network address of variable “F1”) . Then click on “Numeric 
format” to set the “Data format” as “32-bit Float” , “Left of decimal Pt.” as 5 , “Right of decimal Pt.” 
as 3 , “Input low” as -9999.999  and “Input high” as +9999.999 . 
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Then create one Label “Set F1” and move it to just on the “Numeric Input” button. 

 

Then we have finished the “10” window as below. 

 

Then click on “Save” to save it. 
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1.4: Compile / Download and Test the Touch-8000 
Please run “Tools” > “Compile...” to compile the Touch-8000 project . 
 

 
After clicking on “Compile” , if it shows “succeeded” , then the HMI picture can be download to the 
Touch-8000 by steps listed on next page. 
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We are going to download the HMI project to the Touch-8000 by using Ethernet cable. Please make 
sure the Ethernet cable is connected well between PC --- Ethernet switch --- Touch-8000. And also the 
IP, Mask and download password are well set (refer to section 1.2 ) .   
 

Note: The (IP, Mask) setting of the PC must lie in the same domain as the Touch-8000.  
For ex,  PC (192.168.1.20 , 255.255.255.0 ) and  Touch-8000 (192.168.1.179 , 255.255.255.0) is ok. 
However PC (192.168.3.20 , 255.255.255.0 ) can not connect Touch (192.168.1.179 , 255.255.255.0). 
 

Then run “Tools” > “Download...” . Set the correct HMI IP (In this example, we are setting 
Touch-8000 's IP as 192.168.1.179 in section 1.2) and download password (here is using default 
password 111111) . Then click on “Download” . If everything is well set, it will take about 20 to 100 
seconds to download the HMI project. Then the Touch-8000 will reboot itself once automatically. 
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The “On-line Simulation” is one useful utility to test the Touch-8000. Please make sure the Ethernet 
cables are well connected as the following figure. The “On-line Simulation” can simulate the HMI 
picture on PC without downloading to the Touch-8000 (The PC must link to the Touch-8000).  

 

Then run “Tools” > “On-line Simulation”  

 
To exit the simulation, use mouse right-click on the widow, then run “Exit simulation”. 
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Chapter 2 : Some Advanced Topics 

2.1: Connecting one Touch-8000 to Many Controllers 
The Touch-8000 's Ethernet port can link to many ICP DAS Modbus TCP/IP controllers, like the 
WP-8xx7, uPAC-7186EG, iPAC-8x47 or others supporting Modbus TCP/IP slave protocols. However 
recommend not connecting more than 6 controllers (The more connectted, the slower communication 
scan rate).  The COM1: RS-232/485, COM2: RS-232 and COM3: RS-232/485 of the Touch-8000 can 
also link to ICP DAS Modbus RTU controllers, like the WP-8xx7, uPAC-7186EG, uPAC-7186XG, 
I-7188XG, I-8x47, iPAC-8x47 or others supporting Modbus RTU slave protocols. 
 
In the “System Parameters” windows, user can create more than one device. The first “Local HMI” is 
necessary. It defines the Touch-8000 itself. We have created one device in Chapter 1.3, named as 
“PLC1” as below figure. To create one more device, please click on “New” . 



  Getting Started: Touch-8000 HMI Linking ICP DAS PAC and M-7000 I/O Modules                     ICP DAS    38 

Set proper property for this new device. Here we are connecting one another Modbus TCP/IP 
controller with IP=192.168.1.181 , port=502 and NET-ID = 1 (PLC station No.) 
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If the new connected device is a Modbus RTU controller by RS-485 (2 wire) communication, the user 
can set its property as the following figure. Setting the “PLC type” as “Modbus RTU”, “PLC I/F” as 
“RS-485  2W” , PLC default station No. as 1 (can be modified in each object 's address setting) , ...  
 
Note: Recommend connect no more than 7 controllers or M-7000s in each Touch-8000 ’s RS-485 port 
(2-wire). The more connected, the slower communication rate. 

 
Then when creating the HMI object, please select the related “PLC name” and Address similar as 
below. The number before the '#' means the related PLC 's station No. (NET-ID). For ex,  1#20 means 
station No. 1 's address 20 ,  While  2#150 means station No. 2 's address 150 . 
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If the new connected device is a Modbus RTU controller by RS-232 communication, the user can set 
its property as the following figure. Setting the “PLC type” as “Modbus RTU”, “PLC I/F” as 
“RS-232” , PLC station No. as 1 (NET-ID of the new PLC) , ...  
 
Note: Each Touch-8000 's RS-232 port can connect only one controller. 
 

 
Then when creating the HMI object, please select the related “PLC name” as below.  
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2.1.1: Display the PLC communication state (Via Ethernet) 
 

The PLC communication state (via Ethernet) can be displayed on Touch-8000. Below “System 
Parameter” shows there is 2 Modbus TCP/IP PLCs connected by Touch-8000. One is named as 
“PLC1” with “No.” = “Local PLC4” . The other one is named as “PLC2” with “No.” = “Local PLC5” . 

 

To display the communication state of “Local PLC4” and “Local PLC5”, please create four “Bit 
Lamp” as the following figure.  Check the “System tag” and select “Local HMI” to use the 
“LB-10100: PLC 4” to display the communication status of “Local PLC4” and “LB-10400” for “Local 
PLC 5” . The first and second Bit lamps (PLC1 , 0x , addr.=1) and (PLC2 , 0x , addr.=1) are necessary 
to inform  the Touch-8000 to read some value from these two PLCs (using other addr. is also ok). 
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The first and second bit lamps are not necessary to display on the screen (however they are necessary 
to exist for detecting the communication state of the PLC1 and PLC2). So here we can move the third 
and fourth bit lamps to cover the first and second bit lamps as below. 

 
Then we have the following picture. Click on State 1 can view the Label setting of state 1 . 
 

 
Then save, compile and download to the Touch-8000 to test it (steps is similar as Chapter 1.4).  
 
Then user may un-plug the Ethernet cable of PLC1 and PLC2 to see if the third and fourth bit lamps 
change its display. 
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2.1.2: Display the PLC communication state (Via RS-485 or RS-232) 
 

To detect the communication state of the PLC via RS-485 and RS-232 is similar as steps listed in 
section 2.1.1 .  The following figure is using Touch-8000 's COM3: RS-485 to link two PLCs . 

 

The following figure is for detecting two PLC 's communication state via COM3: RS-485. One PLC 's 
NET-ID (or called station No.) is 1 , the other is 2. Please create four “Bit Lamp” as below figure.  
Check the “System tag” and select “Local HMI” to use the “LB-9801” to display the communication 
state of the PLC with Net-ID=1  (via COM3). And “LB-9802” for the PLC with Net-ID=2  (via 
COM3) .  “2#1” means the NET-ID is 2, data address is 1. 
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The first  (1#1) and second bit lamps (2#1) are not necessary to display on the screen (however they 
are necessary to exist for detecting the communication state). So here we can move the third and fourth 
bit lamps to cover the first and second bit lamps as below. 

 
Then we have the following picture. Click on State 1 can view the Label setting of state 1 . 
 

 
Then save, compile and download to the Touch-8000 to test it (steps is similar as Chapter 1.4).  
 
Then user may un-plug the Ethernet cable of PLC1 and PLC2 to see if the third and fourth bit lamps 
change its display. 
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2.2: Screen saver and Back light saver 
User can enable the “Back light saver” or the “Screen Saver” as listed in the below figure.  
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2.3: Confirm after touching a Set-Bit button 
User can enable the “Display confirmation request” on a “Set Bit” object as below figure. The “Max 
waiting time (sec)” define the waiting time if no answer to the confirmation window . 

 
Then when touch this “Set Bit” button, the confirmation window will pop-up. You can try not 
answering it longer than 10 seconds. You can see the pop-up window will disappear . 
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2.4: Setting password security for HMI objects 
The project file of this example : Touch-8000 CD-ROM:\napdos\touch8000\example\touch_03.mtp 
 

The Touch-8000 can setup password to protect each HMI object.  The following example is setting 
User No. 1 as “Class A” with a password number of “12345” . (The user No. can be 1 to 12, the 
password number can be 1 to 999,999,999).  First do “System Parameter settings” as below. Enable 
“User 1” and set as Class “A” and password as “12345” . And also enable the “Back light saver” and 
“Screen saver” as 1 minute, set the startup window no. as “10” 
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Then create the “11” window. 
 

 
Then create one “Page 2” text and one “Logout” function key in the “11” window as below to switch 
to the “10” window. 
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In the “10” window, create two “text” - “User No.” and “Password” and create two “Number Input” 
and one “Function Key” to switch to the “11” window. The upper “Numeric Input” is for entering the 
User No. (1 to 12). Its “PLC name” is “Local HMI” , “Device type” as “LW-9219” and using 
“Keyboard window no” of “50” , data format is “16-bit”. The lower “Numeric Input” is for password.  
Its “PLC name” is “Local HMI” , “Device type” as “LW-9220” and using “Keyboard window no” of 
“52” . data format is “32-bit”. Remember to check on “Mask” for the lower “Numeric Input” . 
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The “Login” Function key to switch to the “11” window in the previous page must set as the following 
figure. Set the “Object class” as “Class A” and check the “display warnning message if access denied”  
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Then please create one “Set Word” in the “10” window as the following. Set “PLC name” as “Local 
HMI” , “Device type” as “LW-9220”  and 32-bit Unsigned, “Set Style” as “Set when window opens” , 
“Set value” as “0” . This “Set Word” should be invisible, so do not check the “Use shape” and “Use 
picture” . 

 
 
 
 



  Getting Started: Touch-8000 HMI Linking ICP DAS PAC and M-7000 I/O Modules                     ICP DAS    52 

We don't want to display any number when entering the password. So delete the ASCII Display of the 
“52” Keypad.  

 
 
Then after compilling , download the HMI project to the Touch-8000, please test it as the following. 
You can see if the User No. and Password is correct, then touch at “Login” will switch to the “11” 
window.   
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2.4.1: Setting password protection for single object 
 
Each HMI object may use security function to protect itself. For example, the following “Set Bit” 
object can be operated only for the User No. with “Class B” checked. User login with other class is 
impossible to operate it. 
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2.5: Display local language on HMI objects 
User can display local language of many countries on the Touch-8000 HMI. For example, the English, 
Chinese, ...  When you edit the text of your HMI objects on the Easybuilder 8000 software, just type 
it by using your local language. 
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2.6: Scaling an integer value or a real value 
In some application, user may want to scale an integer value or a real value to become an engineering 
value and then displayed on the HMI screen.  
 
For example, to scale the integer value  (-32768 , +32767) to become (-10.00 , +10.00) . Here using 
the same Touch-8000 project we have created in the Chpater 1.3.2 > step 12 and step 13.  Please 
modify the “Numeric Display” as the following figure. Modify the “Data format” as “16-bit Signed” , 
“Left of decimal Pt” as 3 , “Right of deciaml Pt” as 2 . Then check the “Do conversion” and entering 
“Engineering low” as “-10.00” , “Engineering high” as “+10.00”  , “Input low” as “-32768” , “Input 
high” as “+32767” 
 

 
Then when you re-compile and download this project. You can see the original value of “16383” is 
scaling to be “5.00”  . 
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2.7: Touch-8000 linking M-7000 I/O modules. 
The project file of this example : Touch-8000 CD-ROM:\napdos\touch8000\example\touch_02.mtp 
 
The Touch-8000 can use its COM1:RS-485  and COM3: RS-485 and COM2:RS-232 plus one 
I-7520R (RS-232 to RS-485 conveter)  to connect many M-7000 I/O modules. 
 
M-7000: http://www.icpdas.com/products/Remote_IO/m-7000/m-7000_list.htm 
I-7520R: http://www.icpdas.com/products/Industrial/communication_module/communication_list.htm 
 
Recommend connect no more than 7 controllers or M-7000 I/O modules in each Touch-8000 ‘s 
RS-485 port (2-wire). 
 
Touch-8000 COM1: RS-485    ICP DAS controller or M-7000    ICP DAS controller or M-7000  
   2 Data +   Data +     Data +  
    1 Data -   Data -     Data - 
    
Touch-8000 COM3: RS-485   ICP DAS controller or M-7000     ICP DAS controller or M-7000  
   9 Data +   Data +     Data +  
    6 Data -   Data -     Data - 
 
Touch-8000 COM2: RS-232             I-7520R      ICP DAS controller or M-7000  
           (RS-232 to RS-485 conveter) 
    6 RXD   2 TXD  Data +        Data + 
    4 TXD        3 RXD  Data -       Data - 
  5 GND   5 GND 
 

Note: If you are not familiar with the Touch-8000 programming, please read Chapter 1.2 to 1.4 first. 
 
Here we are going to build an Touch-8070T HMI project and use its COM3: RS-485 to connect one 
M-7017R (Addr or station No. = 1 , Comm. Parameter = 9600, 8, N, 1) and one M-7067D (Addr  or 
station No. = 2 , Comm. Parameter = 9600, 8, N, 1) . 
 
1. First doing initial setting for every M-7000 I/O module by the DCON utility one by one.   Please 
connect PC 's RS-232 port  to one I-7520R then connect to only one M-7000 to do the initial setting. 
Before doing initial settings , please switch the Dip on the back of the M-7000 module to the “INIT” 
position (Some may have no dip switch, then wire its “INIT*” to GND) and then power on the M-7000 
and I-7520R. 
 
      PC  (RS-232)         M-7520R        M-7000   
  9-Pin DSUB   (RS-232 to RS-485 conveter) 
      2 RXD   2 TXD  Data +        Data + 
      3 TXD        3 RXD  Data -       Data - 
    5 GND   5 GND 
 
Then run the DCON utility in your PC to do the initial setting as listed in the next page. 
Recommend to use the DCON utility version 5.1.2 or later version . It can be downloaded at  
ftp://ftp.icpdas.com/pub/cd/8000cd/napdos/driver/dcon_utility/setup/ 
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Run DCON utility and the set proper “COM Port” setting. (The port No. should be your PC 's port No.  
it can be COM1, COM2, or other COM number) 

 
Then set “Start” as 0 , “End” as 255 and the click on “Start Search” to search the only one connected 
M-7000 module. Its address must be 0 because it is in initial mode . (The Dip on the back is set on 
“INIT” position before power it up) 
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When the Address 0 (or called station No. 0) is found as the following figure, click on “Stop” to stop 
searching and the click on the Module name to do further setting. 

 

Then select “Protocol” as “Modbus RTU”, set proper “Address” (station No. 1 to 247, every M-7000 
in the same RS-485 network should have different Address number) , proper baudrate (every M-7000 
in the same RS-485 network should have the same baudrate). And if the M-7000 has other necessary  
settings, please set it. (Don't mind at the “Checksun” and “Dataformat”, it will auto-switch to “2's 
Complement” and “Enable” when selecting the “Modbus RTU” after the setting) 

 

If all settings are correct, the following window will pop-up. Then please un-plug this M-7000 and 
switch it back to “Normal” mode (Not “INIT” mode) . Then do initial setting for next M-7000.  
Every M-7000 must do the initial setting before they can be connected by the Touch-8000 HMI. 
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Important note for some M-7000 Input modules: 
 
If your M-7000 module is not in the below lists, please go ahead to the step 2. 
 
After the above initial setting is finished , please give below Modbus command to below M-7000 
modules 's Digital input channels to invert them.  
 

 01   46   29  01             (4-byte command, each byte is 2 Hex-number) 
 

The first byte is the M-7000 Address number been set by DCON utility, it may be 01, 02, 03,  ..., 
0F, ...  to  F7 depends on your setting of the related M-7000.  The other 3 bytes   “46  29  01”  
should be always same.  

 

M-7000 Modules should be inverted 

M-7041    ,    M-7044    ,    M-7050    ,    M-7053    ,    M-7060    ,   
M-7063    ,    M-7065      
M-7041D  ,   M-7044D  ,    M-7050D  ,    M-7053D ,    M-7060D  ,   
M-7063D  ,   M-7065D      

 
Please Do Not give the upper command to other M-7000 modules which are not in the above lists. 
 
Steps to invert the digital input channels: 
  Power on the M-7041 or M-7044 or M-7050 or M-7053 or M-7060 or M-7063 or M-7065. Run 
DCON utility to search the module first. If module is found, stop searching. Make sure the Module 
name is one of M-7041 or M-7044 or M-7050 or M-7053 or M-7060 or M-7063 or M-7065. Then goto 
“Terminal” - “Single Line” 
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Select the correct baudrate,  Protocol should be set to “MRTU”. Then type in the inverted command 
as below, the first byte should be the Module's Address number. It can be 01 to F7. And then click 
“Go” . If the response is “01  46  29  ...” , it means command succeed.  Power off this M-7000 
module. And it is well configured. 

 

The first byte is the M-7000's Module 
Address. It can be 01 to F7 
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2. Set proper “System Parameter Settings” in the Easybuilder 8000 software. (If are not not familiar 
with the Easybuilder 8000 software, please read Chapter 1.2 , 1.3 and 1.4). 
 

Please create one new device . This example is create one “Modbus RTU (zero-based addressing)” 
device in COM3 with COM parameter as “RS-485  2W” , “9600, N, 8, 1” (the same setting as the 
connected M-7000).  
 

Note: The PLC type must set as “Modbus RTU (zero-based addressing)” if connecting the M-7000 I/O 
modules. Because they are using the 0-base addressing. They are not like the ISaGRAF controllers 
uising the normal addressing (Modbus RTU). 
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3. In this example, we are connecting one M-7017R (station No. is 1) and one M-7067D (station No. is 
2).  First create one “Numeric Display” and one “Bit Lamp” for detecting the communication state of 
the M-7017R . Please set the “Bit Lamp” 's state 0 with a Label “Err” and state 1 with a Label “Ok” . 
 
Note: For M-7000, “3x” is for Analog input modules, “4x” is for Analog output modules, “1x” is for 
Digital Input modules, “0x” is for Digital output modules. 

 
We don't want to display this “Numeric Display”, so please move the “Bit Lamp” to covert it as below. 



  Getting Started: Touch-8000 HMI Linking ICP DAS PAC and M-7000 I/O Modules                     ICP DAS    63 

Then create two “Bit Lamp” as the following to detect the communication state of the M-7067D.  
Please set the second “Bit Lamp” 's state 0 with a Label “ERR” and state 1 with a Label “OK” . 
 
Note: For M-7000, “3x” is for Analog input modules, “4x” is for Analog output modules, “1x” is for 
Digital Input modules, “0x” is for Digital output modules. 

 
Then move the lower “Bit Lamp” to covert the upper one as below. 
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We have set the M-7017R by DCON utility to measure “+/- 10V” and Addr. As 1 (means station No. 
is 1). So here please create one text as “Ch.1” and one “Numeric Display” as the following figure to 
get the Ch.1 value (1#0 means station No. 1 , Modbus addr. 0) and convert it from (-32768 , +32767) 
to (-10.00 , +10.00) Volt . 
 
Note: For M-7000, “3x” is for Analog input modules, “4x” is for Analog output modules, “1x” is for 
Digital Input modules, “0x” is for Digital output modules. 
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Then please create other text and Numeric Display as the following to get Ch.2 to 8 's analog input 
value.  Copy from the first one and paste to Ch.2 to Ch. 8 .  
 

 
Remember to modify each Numeric Display 's  “Address” to a proper value. Ch.1 is using 1#0 , Ch.2 
is 1#1 , Ch.3 is 1#2 , Ch4. Is 1#3 , Ch.5 is 1#4 , Ch.6 is 1#5 , Ch.7 is 1#6 , Ch.8 is 1#7 . 
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We have set the M-7067D by DCON utility as Addr=2 (means station No. is 2). Please create one “Bit 
Lamp” as the following figure to display the Ch.1 state of the M-7067D (2#0 means station No. is 2 , 
Modbus addr. Is 0). 
 
Note: For M-7000, “3x” is for Analog input modules, “4x” is for Analog output modules, “1x” is for 
Digital Input modules, “0x” is for Digital output modules. 
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Then create two “Set Bit” to switch the state of Ch.1 of M-7067D . (M-7067D is M-7000 Digital 
output module) 
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Please create one another “Bit Lamp” and two “Set bit” for Channel 2 of the M-7067D .  
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We have finished the touch-8000 project. Please save it, compile it and then download it to the 
Touch-8000 HMI. (If you are not familiar with the Easybuilder 8000 software, please refer to Chapter 
1.2 thru. 1.4) 
 
Check if you have connected the RS-485 cable well between Touch-8000 's COM3 and M-7017R and 
M-7067D. 
 
Touch-8000 COM3: RS-485         M-7017R (Addr. 1)         M-7067D (Addr. 2)  
   9 Data +   Data +     Data +  
    6 Data -   Data -     Data - 
 
Then test it. You can try to turn off the power of M-7017R or M-7067D to see if the communication 
state change to “Err”  (“ERR”) .  And give for example , 5 volt to Ch.2 of the M-7017R to see if the 
value displayed well . 
 
Product information : 
  NS-208/NS-205 : http://www.icpdas.com/products/Switch/switch_list.htm 
  ICP DAS ISaGRAF PAC:  http://www.icpdas.com/products/PAC/i-8000/isagraf.htm 
  WinPAC-8xx7: http://www.icpdas.com/products/PAC/winpac/wp-8x47.html 
  Touch HMI: http://www.icpdas.com/products/HMI/touch_lcd/touch_human.htm 
  M-7000: http://www.icpdas.com/products/Remote_IO/m-7000/m-7000_list.htm 
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2.8: More Topics 
Please visit below web sites for more functions about the Touch-8000 series HMI. 
 
English:  ftp://ftp.weintek.com/MT8000/eng/UserManual/ > all PDF files. 
Chinese:  ftp://ftp.weintek.com/MT8000/tw/UserManual/ > all PDF files. 
 
For example, please refer to Chapter 7 and Chapter 13.22 for “Event log” and “Event display” . 
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